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Introduction

Welcome to the WinDupe on-line documentation and help file.      
WinDupe is a Windows 3.x application and uses standard Windows 
techniques.    This document covers areas that are specific to 
WinDupe.    If you need information about using Windows, please refer
to your Microsoft Windows documentation.

Overview

WinDupe makes the chore of copying, comparing, and formatting 
diskettes a snap.    WinDupe loads an image of the selected diskette 
into memory by reading a track at a time, compressing the track, and 
storing it into memory.    The diskette will be loaded up to and including
the last track with data on it to provide the fastest possible load time.    
The diskette image can produce multiple copies of the original diskette 
or be saved to a disk file for future use.    The help menu lists several 
general help areas, including the help index    and help commands.

Procedures

The initial execution of WinDupe provides two primary options --    the 
Load option and the Format option.    The Copy and Compare options 
will be disabled until a diskette image has    been successfully loaded 
into memory.    The File menu allows exit from the program.    And, of 
course, the Help option is enabled at all times.    

The Load option allows the loading of a diskette image by reading a 
diskette or by loading file from disk. 

The Copy option allows copying a diskette image to a diskette image or
to a disk file.    The diskette image may be copied to a diskette of the 
same or higher density.

The Compare option allows the diskette image in memory to be 
compared    to a diskette of the same or higher density.    If the diskette 
is the same density as the diskette image, then the diskette is 
compared track by track until the end of data in the diskette image is 
reached.    If the diskette is a higher density, then only the data area is 
compared until the end of data in the diskette image is reached.



The Format option allows a Quick Format without copying the operating
system (OS), a Quick Format with OS, a Full Format without OS, a Full 
Format with OS and just a transfer of the OS.    WinDupe makes use of 
the Input/Output Control (IOCTL) subfunctions to format diskettes.    
This allows direct communication with the device drivers to provide the
highest degree of compatibility possible.    The Quick Format simply 
initializes the boot sector, File Allocation Table, and Root Directory.    
The Quick Format option requires a diskette to have been previously 
formatted.

WinDupe supports loading, copying, comparing, and formatting 360K, 
720K, 1.2M, 1.44M, and 2.88M diskettes.    

Compatibility

WinDupe is compatible with Microsoft Windows versions 3.0 and 3.1.
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File Menu Help
The File menu allows you to exit the program.

Exit                  Exits WinDupe  



Load Disk Help
The Load menu allows you to load a diskette image into memory from either 
a diskette or a previously saved file.

Diskette to Memory...

Loads a diskette image from diskette into memory.    Select the Load All
Tracks option if you desire to read all tracks.    The default is only tracks
up to and including the last track containing data is loaded.

File to Memory...

Loads a diskette image previously saved as a file by WinDupe into 
memory.    The diskette image must have been loaded from a diskette 
using Windupe and saved as a file from the Copy to File Dialog Box.    
Files with extensions other than .WDF or files that have not been saved
by WinDupe cannot be loaded    by WinDupe into memory.



Load File Help
The File to Memory option allows you to load a diskette image into memory 
from a previously saved file.

File to Memory...

Loads a diskette image previously saved as a file into memory.    The 
Select File dialog box enables you to select the filename of the diskette
image previously.    The dialog box lists the files with the default 
extension WDF.    Once a file is selected (highlighted), the dialog box 
will display disk size and capacity of the diskette whose image will be 
loaded in memory.    In addition, information about the WDF file will be 
displayed.    This includes size of the WDF file and date and time the 
WDF file was created.    To load a file, simply enter a filename on the 
FileName line or select a filename in the Files box and depress the 
ENTER key. 



Copy Disk Help
The Copy menu allows you to copy the diskette image contained in memory 
to a diskette or to a file.

Memory to Diskette ...

Copys a diskette image from memory to a diskette.    The target 
diskette may be    may be different than that of the source diskette 
according to the following table:

Source                  Target  

360K 360K, 720K, 1.2M, 1.44M, 2.88M
720K 720K, 1.2M, 1.44M, 2.88M
1.2M 1.2M, 1.44M, 2,88M
1.44M 1.44M, 2.88M
2.88M 2.88M

The Number of Copies option enables you to copy between 1 and 999 
diskettes in a single operation.    At the conclusion of each pass, a 
dialog box will display the number of the diskette copied and ask 
whether to continue    the copy operation or terminate.

The target diskette will be formatted if Force Format is selected.    When
the Force Format box is checked, a dialog box will appear that will 
afford the opportunity to format the target diskette to the desired 
density.    If the target diskette is not formatted, WinDupe will attempt 
to format the target diskette based on the capacity of the target drive.  
Therefore, if the source diskette is a 360K diskette and the target 
diskette is an unformatted 720K diskette in a 1.44Mb drive, WinDupe 
will attempt to format the target diskette as a 1.44Mb diskette and the 
format operation will fail.    The Force Format option will afford the 
opportunity to select the desired format of the target diskette.

File to Memory...

Copys a diskette image from memory to a file.



Copy File Help
Memory to File option allows you to load a diskette image into memory from 
a previously saved file.

Memory to File...

Saves a diskette image to a disk file.    The Select File dialog box 
enables you to enter a description up to 30 characters of the diskette 
you wish to save to a file.    This will enable to you to quickly locate the 
diskette image when it comes to time to load it from disk into memory. 
The file may be saved to any disk, including diskettes.

Saving a diskette image is very easy.    Simply enter a filename on the 
FileName line and depress the ENTER key.    If the filename you have 
selected already exists, you will have the opportunity to change it if 
you wish.



Compare Disk Help
The Compare menu allows comparing the diskette image in memory to a 
diskette.

Memory to Diskette...

Compares a diskette image in memory to a diskette.

Note:    If a device driver such as Stacker (R) 3.0 for Windows and DOS 
is enabled during the write operation,    a follow-on compare operation 
will most likely fail, even though the file data on the target diskette 
matches the source diskette.    This occurs because drivers such as 
Stacker 3.0 sometimes update the target diskette during write 
operations.    These updates are to device driver areas of the diskette 
and do not affect    files copied to the target diskette. 

Stacker is a registered trademark of STAC ELECTRONICS.



Format Disk Help
The Format menu allows the formatting of a brand new diskette or the 
reinitialization of a previously formatted diskette.    The Operating System 
can also be transferred to the diskette.

Diskette...

Formats a diskette, with or without transferring the Operating System. 
There are five Format Options:

Quick Format without System 
Quick Format with System 
Full Format without System 
Full Format with System 
Tranfer System Only

The Quick Format option simply initializes the boot sector, the File 
Allocation Tables and the Root Directory.    The Quick Format will work 
only if the target diskette has been previously successfully formatted.

The Full Format option in addition to creating the boot sector, File 
Allocation Tables, and Root Directory,defines the sectors, to which 
data will be stored.    The Full Format option will take significantly 
longer than the Quick Option because it has to write to and verify that 
write on every sector on the diskette.    

The Transfer System option will copy the Operation System to the 
target diskette to make it a bootable diskette.



Directory Help
The Directory options enables you to obtain a listing of files contained on a 
hard drive or diskette, or in a .WDF file containing a diskette image.

Disk...

Obtain a directory listing of a diskette or hard drive by selecting the 
desired drive in the Drive listing box and then either double clicking the
drive letter or selecting the Dir push button.

File...

Obtain a directory listing of a .WDF file containing a diskette image by 
selecting the desired file in the File list box, then either double clicking 
on that file or seleclting the Dir push button.    The file directory option 
is currently limited to displaying the only root directory of the    diskette
image in the selected file.    Subdirectories cannot currently be 
displayed.

 



F1=Help Menu Help
Help for WinDupe may be accessed two ways:

- Pressing F1 (when no menu is highlighted).    To exit the F1 = Help 
pulldown menu without taking any action, click or drag the mouse 
anywhere outside the menu, or press the Esc (escape) key.

- Using the Help pulldown menu:

The    Help pulldown menu brings up various types of help which make up the
on-line documentation for WinDupe.

Index

Displays the help index.

Commands
 

Displays the complete list of menu commands.

Print Invoice

 Prints an invoice for registering    WinDupe.    If you are 
evaluating the shareware version of the program, and you intend
to make continued use of it, you are obligated to register the 
program.    Improvements to WinDupe can only be made if you 
support the shareware concept.    Shareware is not freeware or 
public domain software.    There are privileges and incentives to 
becoming a registered user.    Please read the README.DOC file 
for details.

About WinDupe...

Displays a dialog box containing the current program version, 
copyright notice and obligatory head-swelling credits for the 
author.



What is Shareware?
Shareware is copyrighted commercial software that you are allowed to try 
out before you make the purchase decision.    It is a marketing concept, not 
a type of software.

Shareware marketing is typically used when the author doesn't have a huge 
advertising budget.    High end software like Lotus 1-2-3, dBase IV, etc. may 
have advertising budgets of over a million dollars.    A full page 
advertisement in a magazine like PC Magazine can cost over $10,000 an 
issue.    Smaller software companies, like MaeDae Enterprises, usually don't 
have that type of advertising budget so shareware marketing is used.

Many people question whether software distributed via shareware is of as 
high a quality as the software they see advertised in commercial 
magazines.    Good commercial advertising can sell almost any software 
regardless of its quality.    Shareware must be of equal or higher quality than
commercially available software for users to register.    You, the user, have 
the opportunity to evaluate the shareware and find the real gems.    With 
commercial software, you purchase the software and then hope it works as 
advertised.    

Note:    Don't feel guilty about passing around copies of shareware.    You are helping the author 
distribute his software.    Even though shareware is commercial software, you are encouraged to pass
around evaluation copies!



Registration Benefits
Registration benefits include:

1.    The latest version of    WinDupe with no additional information screens.
2.    Unlimited support - written or by phone.
3.    Low cost upgrades.
4.    Notification of enhancements.
5.    A Windows based installation program is included with the registered 
version of WinDupe.    It completely automates the installation process 
including the creation of a program group!

Note:    Shareware relies on you, the user, for its existence.    Your registration will help ensure WinDupe continues 
to improve.    When you register, please take the time to fill out the suggestion form.    We want WinDupe to evolve
so it can better meet your needs.




